THE KANSAS

PUBLISHER

A MONTHLY PUBLICATION FOR THE KANSAS NEWSPAPER INDUSTRY MARCH 9, 2011

INSIDE TODAY
PAGE 2

Kevin Slimp shares his ex-
pertise with some InDesign
shortcuts.

PAGE 3

Jim Pumarlo suggests newspa-
per editors listen to what read-
ers have to say.

PAGE 3

The headline is the attention-
grabber for your advertising,
writes John Foust.

PAGE 4

A trip to Emporia reminds KPA
president Linda Denning of past
mentors.

PAGE 8

Doug Anstaett talks about the
palatability of the political
process.

PAGE 9

Winners of the annual Burton
Marvin awards are the Ottawa
Herald and Wichita Eagle.

KPA CALENDAR

MARCH 13-19
Sunshine Week 2011, spear-

headed by the American Soci-
ety of News Editors.

APRIL 29-30

KPA annual convention,
Junction City Marriott.

JuLy 20
NNA Governmental Affairs
Conference, Washington, D.C.

SEPT. 22-25

NNA annual convention,
Albuquerque.

Sunshine Week is March 13-19

promote a dialogue about the importance of

open government and freedom of infor-
mation. Participants include news media, civic
groups, libraries, non-profits, schools and others
interested in the public’s right to know.

Sunshine Week as a national effort is spear-
headed by the American Society of News Editors.
The key funder has been the John S. and James
L. Knight Foundation, with significant support
from ASNE Foundation. In 2011, The Gridiron
Club and Foundation contributed $10,000.

“We encourage all Kansas newspapers to
publish information on the importance of open

E ; unshine Week is a national initiative to

government to our democratic system of gover-
ance,” said Doug Anstaett, executive director of
the Kansas Press Association.

Though created by journalists, Sunshine Week
is about the public’s right to know what its gov-
ernment is doing, and why. Sunshine Week seeks
to enlighten and empower people to play an ac-
tive role in their government at all levels, and to
give them access to information that makes their
lives better and their communities stronger.

Sunshine Week is a nonpartisan, non-profit
initiative. To download information including
cartoons, columns and other materials, go to:
www.sunshineweek.org.

KPA annual meeting set April 29-30

Agenda includes Ft. Riley tour, speed topics, special awards

Press Association will include a tour of
Ft. Riley, speed topics on a variety of
subjects and intensive training opportunities in
news and advertising.
This year’s convention is April 29 and 30 at
the Courtyard by Marriott in Junction City.
“We’ve lined up a variety of training oppor-
tunities for our members, and we’re bringing

The 119th annual convention of the Kansas

back the highly-regarded speed topics at this
year’s convention,” said Emily Bradbury, mem-
ber services director.

Featured speakers will be Jim Pumarlo,
a regular columnist for the monthly Kansas
Publisher, and Tim Smith, an advertising sales
trainer who will deliver programs on prospect-

See CONVENTION on Page 8
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Almost everyone wants help
with InDesign when he visits

hen a newspaper or group
contacts me to ask about train-
ing, they usually have some-

thing specific in mind. The client might
be a publication moving to the InCopy/
InDesign workflow. Quite often, there’s

a problem with print quality. No matter
what the reason for my visit, it’s almost a
certainty that [ will be asked to give some
advanced InDesign training while on site.

When I first started using InDesign,

then known as “K2,” over 11 years ago,
one of the first things I noticed

Let me tell you how it works.

The goal of Make Grid is to create an
area filled with frames to be filled with
items. In our business, the best example
might be the realty add that contains 15
to 30 house photos. Without Make Grid,
most designers would probably create
one frame, then duplicate it throughout
the page using guidelines or the “step
and repeat” tool in InDesign. Make Grid
speeds the process up significantly and
guarantees that your spacing is accurate

throughout the area. Here’s

was how easy it was to learn
the ins and outs of the applica-
tion. It became apparent pretty
quickly that there’s not a lot of
“advanced” to InDesign. There
are just tools that users haven’t
had the time to learn.

To this day, I get a kick out
of seeing longtime InDesign
users smile when they learn
how to create text in various
shapes or to fill a letter of the
alphabet with small text instead
of a color. With that in mind,
let me share an InDesign process that will
save ad designers serious minutes when
they’re laying out realty or auto ads.

This task is accomplished using an In-
Design script. Scripts are little programs
that allow users to accomplish tasks that
would otherwise take much longer. Pho-
toshop veterans are

Kevin Slimp

how it works:

1. Create a frame (a rect-
angle) that fills the area where
you want your photos to appear
on the page. If you’re design-
ing an auto ad with 15 cars,
draw a frame (using your rect-
angle tool) where you want the
15 cars located on the page.

2. Select the frame
with your selection tool
(black arrow) and go to
Object>Fitting>Frame Fitting
Options. Set Fitting to “Fill
Frame Proportionately” and select the
middle dot in the “Align From” option in
the Frame Fitting Options window. Click
OK to exit that window.

3. Next, go to the Scripts panel. In
the most recent version of InDesign, it
is found by selecting Window>Utilities
>Scripts. In some

used to using actions The goal of Make Grid carlier versions, you

to get similar results. . found this script by
There are scripts is to create an area filled selecting Windows>

to automate the with frames to be filled Scripting>Scripts.

creation of calendars
in InDesign. One of
my favorite scripts
from the early days
of InDesign was
called “Pie Graph.”
It allowed the user to

with items. Make Grid
speeds the process up
significantly and guaran-
tees that your spacing is
accurate throughout ...

You may have to look
through the options
under the Win-
dows menu to find
“Scripts,” but it will
be there.

4. Beginning

create a circle, enter a
series of values, then
sit back and have a snack while InDesign
created a beautiful pie chart. The whole
process took no more than a few seconds.
During a recent session of the Institute
of Newspaper Technology, I asked a class
of advanced InDesign students if anyone
had a time-saving tip to share with the
rest of the group. Emily, from Salem, In-
diana, was quick to respond with a lesson
on the “Make Grid” script in InDesign.

with InDesign
CS3, users will
find scripts already built into the
Scripts menu. To find them, look un-
der Applications>Sample>Javascript
in the Scripts panel. Prior to CS3,
InDesign didn’t supply any scripts
to go in the panel. Users can down-
load scripts at no cost from Adobe.

See SLIMP on Page 4
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Have you listened to your readers lately?

en is the last time readers
complained about the accuracy of
a story? Or called to say they’re

pleased with a story but irritated by a head-
line? Or found fault with how their ideas
and statements were conveyed in a story?

News staffs translate hundreds of facts
daily — some infor-
mation is received
firsthand and other
secondhand. Some
facts are included
in comprehensive
reports on important
community subjects.
Others are part of the
daily churn of police
reports, obituaries,
weddings and engage-
ments, and govern-
ment meetings.

Through all of
these stories, one tenet governs the work of
newsrooms: accuracy. If the facts are wrong,
the newspaper loses its credibility.

In the pursuit of fairness and accuracy,
newspapers should consider implementing
a “fact check” sheet. Individuals who either
are sources or subjects of news stories are
the best judge of how editors and reporters
are doing their jobs. So why not ask them

Jim Pumarlo

directly.

The process can be straightforward.
Select a couple of stories from each edition
and send a copy to an individual who either
was contacted or who might have been
identified in each story. Then ask a series of
questions. For example:

Are the facts in the story/photo accurate,
including spelling of names and addresses?

Were the

tion? How long have you subscribed to this
newspaper? If you do not subscribe to this
newspaper, why not? Can we improve upon
customer service — in any department?

Newspapers should regularly check in
with their customers to see how they are do-
ing their jobs. And there are other avenues
to do so:

* “Ask the editors” night — Open the
telephone lines

quotes attributed
to you used in
proper context?

In general, do
you consider this
newspaper to be
accurate?

Other ques-
tions regarding

newsrooms.
news content

Jim Pumarlo will be one of
featured speakers at the 2011
Kansas Press Association an-
nual convention April 29 and 30
in Junction City. He will pres-
ent programs on issues faced by

for an evening
to let readers
ask anything
on their minds.
Top-level man-
agers from the
various depart-
ments should
be on hand
with the goal

can be asked as
well. What are the most interesting sections
of this newspaper? Do other topics or issues
warrant attention? Are any “voices” or con-
stituencies lacking in coverage?

The “fact check” is an excellent tool to
ask additional questions about your news-
paper beyond strictly the news product. For
example: What’s your primary source of
news? What other publications/media out-
lets do you routinely depend on for informa-

of answering as
many questions on the spot as possible. If
you don’t have the answer, take down the
customer’s name and telephone number and
respond within 24 hours. This is an excel-
lent promotion during National Newspaper
Week, but it obviously can be done any
time.

* “Brown bag” lunches — Convene a

See PUMARLO on Page 7

Headline is the attention-getter; make it snappy!

esearch shows that the headline is
Khe most important part of a print ad.
f you have a headline that hits home
with a reader, there is a good chance that he
or she will read further. If not, you’ve lost
your chance.

Here are some
ideas to power up your
headlines:

1. Start with a verb.
When you lead off with
a verb, you can trans-
form a message from
passive to active. A
verb puts readers in the
present tense and calls
them to take a specific
form of action. Go...
find...get...take...try...:
these are all verbs that add life to a headline.

A lot of times, a small adjustment is all
it takes. For example, “Get a free widget
when you test drive a Zoom-mobile” is
better than, “Zoom-mobile will give you a
free widget with a test drive.” See the dif-
ference?

John Foust

2. Start with “how to.” This is a handy
copywriting tool. These magic words can
create a superhighway to a benefit headline.
Part of the magic is in the fact that, once
you’ve written the headline, you can drop
the words “how to” and still have a benefit
headline. “Do yard work faster” promises
the same benefit as “How to do yard work
faster.”

3. Use the word “free.” In the Zoom-
mobile example, the verb “get” is connected
to a free offer. This is a strong combination,
because a timely giveaway will never go
out of style. Consumers love to receive free
things.

Free offers can be used to promote
anything from restaurants (buy one pizza,
get one free) to clothing (free alterations
with new suit) to real estate (free relocation
information).

4. Use the word “save.” This is one of
the strongest verbs in your toolbox. Once
again, it’s all about benefits. Show readers
how they can save money, time, or some
other valuable commodity, and you will
have their attention.

5. Use specific dollar amounts and per-
centages. Specifics always sell better than
generalities. “Take $2,000 off the purchase
of your new car” is better than “Take a big
discount on the purchase of your new car.”
And “Save 25% on new carpet” is more
compelling than “Save a lot on new carpet.”

Using specific numbers can help ad-
vertisers avoid meaningless phrases like
“fantastic deals,” “unbelievable bargains,”
and “best prices ever.” As a result, their
messages will have more clarity and impact.

6. Use short words. Two facts are worth
mentioning: (1) People read publications
— including newspapers — at a glance. (2)
Short words are easier to read than long
words.

The challenge — and the solution — is
obvious. Use short words, and you’ll give
your headline stopping power. You’ll make
it easier for those hurried page turners to
catch the essence of your message.

John Foust can be contacted at
Jfoust@mindspring.com. (c) Copyright
2011 by John Foust. All rights reserved.
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Trip to Emporia triggers some great memories

Imost 40 years ago, I packed up my
Arusty green Buick and headed south

through Indiana on Interstate 69. My
destination was Kansas and a job market
that [ hoped would be better than the one
where I was raised. =

My belongings con-
sisted mostly of books
and an ironing board
my aunt and uncle gave
me as a graduation pres-
ent.

I remember the
ironing board because it
was on top of the spare
tire I needed from the
truck to get past Terre
Haute, Ind. The iron-
ing board and several layers of books ended
up along the side of the interstate for a time
as [ removed the spare to change a flat tire.

A high school friend who had moved to
Topeka invited me to Kansas and I decided
to use the opportunity to job hunt. A week
after arriving, I landed at the Salina Journal,
resume in hand. There probably aren’t a lot
of you who remember the people I’'m about
to mention, but those of you who do remem-
ber will appreciate the irony of my situation.

Glenn Williams, the Journal’s managing
editor, hired me over the objections of pub-
lisher Whitley Austin, who said I couldn’t
type fast enough. Of course, I'm sure it
never occurred to Mr. Austin that I would
have done better had he not looked over
my shoulder as I struggled to find the keys
through the cloud of smoke from his cigar.

Mr. Austin grew up in Emporia and was
influenced greatly by William Allen White.
In fact, he worked for White. To say Mr.
Austin was intimidating is like saying Larry
Bird was a good basketball player. Both
would be vast understatements.

Hiring me was probably one of the few
times — perhaps the only time — Glenn
didn’t follow Mr. Austin’s recommendation.

Linda Denning

These were much different times from
now. Women were common in newsrooms,
but still viewed with some suspicion.

I hold degrees in economics and politi-
cal science and an editor once told me he
planned to reassign a story to a male report-
er because of the story’s complexity. The
editor made it clear he didn’t think women
could handle the important stuff. It was
such experiences that just made me angry
and more determined

That’s no longer true; however, in many
ways I think newspapers — especially those
that serve their communities well — are
more important than ever. My newspaper
certainly has more at stake in Ellsworth’s
success than the local cable company, which
also serves dozens of other communities.

Mr. Austin loved the news business. And
he loved his community. When Salina’s
economy was devastated in the 1960s by the
closing of Schilling Air

to be even better at my
chosen craft.

Those times also
provided wonderful
stories.

Our sports editor at
the time, Bill Burke,
occasionally tapped
ashes from his cigar
into a waste paper bas-

Perhaps the most im-
portant lesson I learned
from him was not to be
afraid of change. Actu-
ally, I can’t imagine Mr.
Austin being afraid of
much of anything.

Force Base, Mr. Austin
was one of the com-
munity leaders who
worked to repair the
damage — and make
the town even stronger.
Perhaps the most
important lesson I
learned from him
was not to be afraid

ket as he rushed to his
next assignment. More
than once, this practice caused a minor fire
in the newsroom. The last time it happened,
Mr. Austin went for the fire extinguisher,
which he used to spray Bill from head to

toe while the fire in the waste paper basket
continued to burn. Then Mr. Austin walked
back to his desk. There were no more fires.

(Bill, who died of cancer in the late
1970s, was so beloved by the community of
Salina that the town’s major sports complex
carries his name.)

Many of these memories came back
during a recent meeting of the Kansas Press
Association board of directors at the Wil-
liam Allen White home in Emporia. Such a
remarkable man. Such an interesting place.

Many of us today look back on White,
Austin and other editors of that time as
giants. Of course, their words didn’t have
to compete with the internet and dozens
of other media outlets. For most of their
careers, they were the only voices in their
communities.

of change. Actually,
I can’t imagine Mr.
Austin being afraid of much of anything.

For most of his career, Mr. Austin typed
his editorials on a typewriter with a hunt
and peck system. Before he retired in the
mid-1970s, he was responsible for the
conversion of his newsroom to computers.
He also guided the Journal’s move to color
photographs.

Every so often, something happens at
my newspaper and I catch myself thinking,
“What would Mr. Austin have done?”

Simple question, really. Mr. Austin
would have done what he had to do, what
he wanted to do. He was always ready to
experiment to make his newspaper stronger,
both editorially and financially. Sometimes
his ventures worked; other times they didn’t.

He never made any apologies either way.

Linda Denning is president of the
Kansas Press Association and editor and
publisher of the Ellsworth County Indepen-
dent-Reporter.

Slimp

Continued from Page 2
com>Downloads>Exchanges. Click on
the InDesign option to select from hun-
dreds of scripts and plug-ins.

5. Double-click on the script “Make
Grid.”

6. A window will appear on the screen,
prompting the user to input the desired
number of rows and columns, along with
the space between them. After entering
the number of columns, rows and gutters,

click OK.

7. You should see the area filled with
frames, ready to be filled with pictures
of houses, cars or whatever. Go to
File>Place and select the photos that you
want to use. Click on each frame individ-
ually to fill it with one of the correspond-
ing photos.

That’s it. You’ve now accomplished
a task in a matter of seconds that would
have taken several minutes without the
use of the Make Grid script.

If you’re not already using
scripts in InDesign, you are about to find

out just how valuable they can be. A few
other good ones to try in InDesign in-
clude “Split Story,” which allows the user
to break jumps into separate stories, no
longer linked together; “Image Catalog,”
which creates a visual catalog of all the
images in a designated folder; and “Sort
Paragraph,” which alphabetizes a list of
items.

So what are you waiting for?

Kevin Slimp is a speaker and trainer
in the newspaper industry. He can be
reached at kevin@kevinslimp.com.
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Keep up with your readers, create new revenue streams and ...

B¢ ahead of the curve!
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Pixel Power Haus creates iPhone,

iPad and Droid applications that
will keep you at the forefront of

SR | informing your community.

Let our team of experts put your

publication ahead of the pack.

To find out how we can help, call
Ron Fields at (800) 657-6017 or
email rfields@dailynews.net.

Pixel Power Haus is a division of The Hays Daily News. Created by a newspaper, for newspapers.
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NEWS BRIEFS

Casey Medal program seeks applications

pplications are being accepted for the 17th annual Casey Medals for Meritorious
AJ ournalism honoring distinguished coverage of children, youth and families.
First-place winners receive $1,000 and are honored in an awards ceremony

in Washington, D.C. Categories include newspaper, video, magazine, audio, multime-
dia and photojournalism. First-place winners will also be considered for the America’s
Promise Journalism Awards for Awareness and Action, presented by the America’s
Promise Alliance. Alliance winners receive $5,000 and will be announced in October.
Work must be published or broadcast between Jan. 1 and Dec. 31, 2010.

Entry deadline is Friday, April 15, 2011. For more information, go to: http://www.
journalismcenter.org/content/history-and-guidelines

The awards were created to inspire and recognize exemplary reporting on children
and families. Winning stories offer a fresh take on a significant issue, show enterprise
in research and reporting and demonstrate masterful storytelling and impact. Judging is
conducted by respected journalists and journalism educators.

The Journalism Center on Children & Families is a nonprofit resource center based
at the University of Maryland’s Philip Merrill College of Journalism. More than 4,500
journalists have competed for Casey Medals since 1994.

The awards are funded by the Annie E. Casey Foundation.

Max Moxley, 1913 - 2011

Former Sterling Bulletin editor Moxley dies

memorial service for Max Moxley, longtime editor of the Sterling Bulletin, is set
Afor 10 a.m. March 23 at First United Methodist Church in Sterling.
Moxley, 98, died Feb. 24.

He married Sara Charlene Schiveley in 1940. She died in 2000. There are no survi-
vors. Moxley was a University of Kansas journalism graduate. He and his wife pur-
chased the Bulletin in 1945. They operated it until selling to Karl Gaston in 1975.

For the full obituary, go to:

http://www.kspress.com/view.asp?1D=380

THIS MONTH’S QUESTION

Q. I notice we tend to have our annual conventions in the same
three or four cities. Does KPA look at other locations?

A. Yes. We would love to come to every corner of the state, but
most hotels cannot accommodate our meeting size. We’ve looked
beyond Topeka, Wichita, Lawrence, Overland Park and Junction
City and will continue to investigate in future years as new hotels
are built. If you believe your community can handle a convention
our size, please contact Emily Bradbury with contact information.
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JOB OPENINGS/FOR SALE

MANAGEMENT

Publisher — The Parsons Sun is currently
in search of an enthusiastic leader. Ex-
perience in the newspaper industry with

a proven track record a must. Our leader
must demonstrate team-building skills, be
customer driven and represent the news-
paper in the community. Experience in
advertising management preferred. We are
independently owned and offer competitive
salary with bonus plus full benefits. Send
a detailed resume with professional and
personal references to: brucewallace03@
gmail.com.

ADVERTISING DIRECTOR - The Daily
Union in Junction City, Kansas is seeking
an experienced, high-energy and team ori-
ented professional to lead the advertising
sales operation for our five-day newspa-
per, three weekly newspapers and online
publication in northeast Kansas. Other

key responsibilities include leadership in
the circulation department. To apply send
resume to: t.hobbs@thedailyunion.net.

NEWS
The Hays Daily News — the Kansas Press
Association’s top mid-sized daily news-

paper in 2010 — is seeking a reporter to
cover the challenging county government
beat, as well as collaborate on story-telliing
in our expansive western Kansas coverage
area. The HDN newsroom values team-
work above all else, and seeks candidates
who adhere to that principle. Candidates
who have experience in video editing,
social networking and digital presentations
will be shown to the front of the line. Sub-
mit your resume to Ron Fields, managing
editor, at rfields@dailynews.net by March
18.

MANAGING EDITOR — Weekly in
southeast Kansas county seat city seek-
ing managing editor. Circulation is near
population. Salary negotiable. Contact
Randy Kensinger at 816-726-3111 or
e-mail randy.kensinger@yahoo.com or the
newspaper at news@erierecord.com.

WANTED - Eager, hungry news hound as
a full-time area reporter. Job involves cov-
ering whatever comes up in a multi-county
area. We need someone who can sniff out
stories and possess a passion for telling
those stories. Involves some weekend and
evening work. Must be reliable, understand

Pumarlo

Continued from Page 3
series of conversations with readers. Buy

your customers lunch in exchange for their
feedback. If you’re soliciting comments on
overall content, be sure your participants
are representative of your community’s
demographics. Or maybe tailor the session
and its participants to a specific content
area — for example, agriculture, business or
youth coverage.

* Reader boards — Organize a board com-
prised of readers with rotating membership.
The individuals meet with the editor on a
monthly basis and offer everything from
editorial ideas to a critique of newspaper
content.

The “fact check” is most useful as a
regular connection with readers. Be sure to
vary your selection of stories from routine
news briefs and meeting reports to in-depth
series and feature stories. If applicable, it
might be worthwhile to send the same story
to two different individuals to see if they of-
fer similar perspectives on the report. Share
the feedback with the individual writers
whose stories were selected as well as with
the entire news staff and other departments.

The concerns or ideas identified on the
questionnaires will offer insight into what
readers believe your newspaper is doing
right and will challenge editors to improve
areas where their staffs are not meeting
expectations. The goal is to solicit feedback
from a range of readers — new and longtime
residents, young and old, men and women
— and from a geographic representation of
your markets.

Newspapers should be sincere in asking
readers to be honest and straightforward
in their answers, underscoring that the
feedback will direct your staffs to strive a
stronger product. At minimum, these ‘fact
checks” earn newspapers high marks for
showing concern about accuracy, fairness
and breadth of coverage. The comments
often can prompt a follow-up phone call and
a fruitful conversation beneficial to both the
reader and editor.

Editors also should seize the opportu-
nity to explain to readers in a column what
you’ve heard and what steps will be taken to
address the concerns.

Jim Pumarlo writes, speaks and pro-
vides training on Community Newsroom
Success Strategies. He can be contacted at
www.pumarlo.com.

deadlines, accurate, comfortable with
computers/websites and be willing to hit
the ground running. If this fits you, please
send letter, clips, resume and references to
Dale Hogg, managing editor, Great Bend
Tribune, PO Box 228, Great Bend, Kan.,
67530, or to dhogg@gbtribune.com.

ONLINE

For much less than you think, you can
take charge of your online future. Let The
Hays Daily News’ Pixel Power Haus take
your newspaper to the next level, whether
you are considering your first website or
looking to retool your existing one. Call
Patrick Lowry at (785) 628-1081 to hear
how we can help. Designed by a newspa-
per, for newspapers.

FOR SALE

The Washington County News, Wash-
ington, KS (785/325-2219) has on hand
a never opened box of 500 #944 layout
sheets for $175 OBO plus freight. Please
call with questions or if you would like to
purchase.

NEWSPAPER FOR SALE

For sale — Erie Record, a southeast
Kansas county seat weekly with 1,200 paid
subscribers, is for sale. Highly motivated
seller. E-mail news@erierecord.com or
call 620-244-3371 (Erie Record) or 816-
726-3111.

Never miss a sales opportunity

AGAIN.

Get the co-op info you need
to sell your advertiser
through your
smartphone.

Show them the ad dollars
and options available to
them—on the spot!

Multind

309.690.5385 | recas@multiad.com
multiad.com/recas
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No one is safe when the Legislature is in session

ich Gannon and I are — understand-
Rably — asked about this time of

year what is going on in the Kansas
Legislature.

Our answer this year is: “We don’t know,
and neither does anyone else.”

A governor with a mandate seems to
have two houses of the
Legislature in the palm
of his hand, yet he is
having difficulty mov-
ing his agenda forward.

How can that be?

Well, it’s because he

has four political parties
to deal with in Kansas:
Democrats, moderate
Republicans, conserva-
tive Republicans and
Tea Party newbies.

So, what leaders in both parties and both
houses seek to do is build coalitions, but the
ultimate goal is to “win.”

This “T’ll scratch your back if you
scratch mine” approach usually bears fruit
at some point in the session. It’s not new
this year, but we’re hearing more than usual
about bills being “held hostage” so some
“horse trading” can take place.

Perfectly good bills are delayed to be
used as leverage to get something the other
side wants.

“I want this ... you want that ... so let’s
negotiate,” the conversation goes.

Doug Anstaett

It’s the political process, which has often
been compared unfavorably to the art of
sausage-making. Spend a few weeks in the
halls of the Capitol and you’ll likely decide
that sausage-making is more fun to watch
— or at least more appetizing.

It does seem that

decency to hang around and see what the
opposition might have to say. She didn’t
care to hear the other side.

No matter ... now, she can run for
re-election on her record of trying to hold
schools accountable, or as Capitol ra-

conteur/columnist

our elected officials get
bogged down every ses-
sion in issues that don’t
really mean much to the
average citizen.

They seem to spend
an inordinate amount of
time politicking rather
than legislating.

Why? Well, partly
because it’s much easier
to push ideas that have

no chance of passing passage.

... It’s much easier to
push ideas that have no
chance of passing for
brazen political reasons
than it is to take a good
idea and shepherd it
from its introduction as
a bill to its final

Martin Hawver often
describes it, her effort
will provide “a bullet
point for her palm
cards” in the next
campaign.

So what is going on
with KPA’s issues?

They’re still there
somewhere. Public no-
tice is under attack and
probably always will
be. There are so many

for brazen political rea-
sons than it is to take a
good idea and shepherd it from its introduc-
tion as a bill to its final passage.

Here’s an example for you. On Tuesday,
a House member floated a bill that would
penalize public schools when one of their
“products” had to take remedial classes at
the college level. The legislator’s theory was
that the school where those students gradu-
ated had failed them, so the school should
suffer by receiving less state aid.

But when the legislator realized her
bill would not fly, she didn’t even have the

ways for something

bad to sneak up on us
that we may take publisher Dane Hicks up
on his suggestion that we camp out in the
Capitol Rotunda until the end of the session.

No, none of us is safe as long as the
Legislature is in session.

So Rich and I will continue to watch
closely, hold our breath, consume Tums by
the bottleful and work diligently until the
final gavel signals the end of the session.

Doug Anstaett is executive director of
the Kansas Press Association.

Convention

Continued from Page 1

ing, time and territory management.
Smith has delivered tailored training
programs to the newspaper industry for
eight years.

Pumarlo has 27 years’ experience
working at small daily newspapers in Min-
nesota. He is a regular columnist for this
publication and the author of “Bad News,
Good Judgment: A Guide to Reporting on
Sensitive Issues in a Small-Town News-
paper.”

The convention will kick off on Friday
with a tour of the home of the Big Red
One at Ft, Riley. Friday night’s banquet
will include the traditional special awards
and the naming of two new members to
the Kansas Newspaper Hall of Fame.

In addition to presentations by Pumarlo
and Smith, convention registrants will be
able to choose from a number of topics in
the “Speed Topics” portion of the meeting
on Saturday.

Speed topics in-
clude:

O How You Can
Improve Your Legisla-
tive Coverage.

3 Online Video
Tips.

O Selling and Cus-
tomer Service: Impor-
tant Allies.

O Quick Photogra-
phy Tips.

3 Circulation Open
Roundtable.

(3 Ask the Media Lawyer.

3 Coaching Skills for Managers.

O How to Use KansasOpenGov.org.

O Editorial and Opinion Writing.

(3 Why You Need a Mobile Presence.

0 Why We Love the new KPA Website.

(O The KDAN and KCAN Networks:
Why Should I Join?

O Important Information to Know
When Reporting on Public Safety Issues.

American Opinion Research will pres-
ent research results on “What Do Print

Tim Smith

Readers Want?”” and
“Growing Newspa-
per Websites.”

Featured sponsors
of this year’s con-
vention are Kansas
Action for Children,
Kansas Policy Insti-
tute, Kansas Electric
Cooperatives and
AAA.

A new feature this
year will be a student
rate for those who
are employed by KPA newspapers or KPA
collegiate members.

The convention will be capped off by
the presentation of the Awards of Excel-
lence in news and advertising on Saturday
afternoon.

Registrations are due by April 15. Early
registrations are encouraged and appreci-
ated.

A registration form is attached to to-
day’s Kansas Publisher. If you have ques-
tions, email ebradbury@kspress.com.

Jim Pumarlo
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Winners of the Burton Marvin awards were (top from left) Ottawa Herald staffers Mea-
gan Patton-Paulson, Tommy Felts, Courtney Servaes, Jenalea Myers and Jeanny Sharp,

and (bottom from left) Roy Wenzl and the Wichita Eagle, shown with deputy editor/news
Jean Hays. (Photos by Doug Anstaett)

Herald, Eagle win Burton Marvin awards
LAWRENCE — The Wichita Eagle and the Ottawa Herald were winners of the

2010 Burton W. Marvin Kansas News Enterprise Award.
Given since 1974 by the William Allen White Foundation, the Burton Marvin
Award recognizes outstanding reporting by newspapers in Kansas and was presented
during William Allen White Day activities at KU in February.

The Wichita Eagle won the award for “Promise Not to Tell.” The three-part series ex-
amined the story of 19-year-old twins Kellie and Kathie Henderson, who were raped and
assaulted from the ages of 3 to 13 by their older brothers and father before being rescued
by neighbors Shelly and Jim Vasey and police in 2005.

Wenzl spent more than 100 hours of interviews in developing the series.

Read the series online at the Wichita Eagle’s website at http://www.kansas.com/
promisenottotell/

In the community category, the Ottawa Herald won for “School Cuts,” a five-part
series that examined many of the cost-cutting changes potentially being considered by
the four local school districts.

Herald staff explained the options for each district to deal with state budget cuts in
winter and spring 2010. They examined in-depth what the cuts would mean to each
district and what might be lost.

According to the judges, the coverage reflected the Herald’s initiative and com-
mitment to persistently and effectively gather information that had significance to the
newspaper’s readership.

9

NEWS BRIEFS

Harper Advocate Publisher Ken Leu is
recovering from a broken femur and hip
suffered when he fell off a fire truck in
February.

He’s also the Harper fire chief.

He underwent surgery at Via Christ-St.
Francis Hospital in Wichita.

Wendy Nugent of the Newton Kan-
san received a second place award in the
Feature/Single Picture monthly clip contet
with the National Press Photographers
Association Region 7 for December. The
photo was a harpist Jill Wiebe performing
at Prairie Harvest.

The Wilson County Citizen recently
began its 141st year of publication. As
co-publisher Rita Relph pointed out in a
column, “The Citizen isn’t a knock-off or
stepchild of some earlier publication. It
was the Wilson County Citizen since John
S. Gilmore set his first line of type.”

Stefanie Cope has joined the Colum-
bus Daily Advocate as a staff writer. She
is a December graduate of Pittsburg State
University.

“I can remember when I decided that
journalism was the career I wanted to pur-
sue,” she wrote in an introductory column.
“I was in the sixth grade. I’d gotten my
first Minolta SLR ... and a few months
later I had decided that I wanted to be a
photojournalist.”

The Associated Press is offering
a package of more than 50 Civil War
pictures in connection with the 150th
anniversary of the start of that conflict on
April 12, 1861.

The collection is available for $75 at:

apispecialcollections!ap.org.

The Wichita Eagle continues to offer
Kansas sesquicentennial stories and pic-
tures for free to Kansas Press Association
members. The Eagle has even provided a
budget of the stories that will be running
this year.

Photographs to accompany the articles
are at: http:tinyurl.com/wichitacagle.

Angela Powers, director of the A.Q.
Miller School of Journalism at Kansas
State University, leaves next week for a
six-week fellowship at the Media Man-
agement and Transformation Center in
Jonkoping, Sweden.

She will be conducting research related
to news quality across countries.
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Using the Freedom of Information Act

Federal law entitles anyone to request a copy of any record from any agency in the executive branch,
except for presidential records and nine exempted types of information; how to make a Freedom
of Information Act (FOIA) request:

Before beginning: Locate appropriate official and make an informal request for the record

Written request

1. Write letter to agency’s FOIA

officer requesting record

2. “Reasonably describe”

docket number not necessary

3. Be persistent; follow up frequently

with agency officer

You can request

= Papers

= Reports
» Letters

record; file or

* Films

= Computer tapes

* Photographs

» Sound recordings

= E-mails

For government help
filing a request, call
(202) 514-3642

Agency’s response

B Agency has 20 working days

to release records or they

deny the release of records based on

exemptions within the law

W May in some cases get

W May charge “reasonable” search
fee, about $11 to $28 an hour; it may

be reduced or waived

Exempted categories

can delay or

* National security

= Personnel documents

» Records exempted by law
= Trade,

commercial secrets

* Internal agency messages

extra time

You may file appeal ...

Agency's FOI appeals officer handles appeal

You may file lawsuit in federal district court ...
If you win, judge orders agency to supply
information, may award you legal fees

Source: Reporters Committee for Freedom of the Press

Agency sends you
copies requested

... if agency does not
answer letter within
20 working days

1 YES

’ YES

= Officials’ personal records
= Criminal investigations

» Federally regulated banks
* Oil and gas wells

... if agency withholds
some or all
information

’ YES
If appeal is denied

@ 2009 MC

This is an example of the kind of artwork available in the Sunshine Week 2011 toolkit. Newspapers should take advantage
of this during Sunshine Week March 13 - 19.
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Thursday, April 28

6 - 8 p.m.
KPA Board Meeting

Friday, April 29

7 a.m. - 8:30 a.m.

KNF Trustee Meeting

8am.-9pm.
Registration and Contest Display
The registration desk and contest display room will open at 8 a.m.

8:30 -9 a.m.
Continental Breakfast

9am. -3 pm.

Tour of Fort Riley - Back by Popular Demand!

Since we last visited, hundreds of millions of dollars have been
spent on improvements at Fort Riley. Join us for unprecedented ac-
cess to one of the premier army bases in the country. The day will
be filled with activities, such as a briefing by top army officials, tour
of Fort Riley, participation in the combat skills training simulators
and lunch at the dining center. Sign up today to get your creden-
tials.

3:30 - 4:30 p.m.
Daily Roundtable - 1
Nondaily Roundtable - 1

6 -7 p.m.
President’s Reception

7- 9 p.m.

President’s Banquet

Enjoy a sit-down dinner as we recognize this year’s recipients of the Clyde
M. Reed Jr. Master Editor Award, Boyd Award for Community Service,
Victor Murdock Award, and the Gaston Outstanding Mentor Award.
We'll also induct new members into the Kansas Newspaper Hall of Fame.

9-11pm.

President’s Hospitality Suite

Join President Linda Denning as we toast to her year as president of the
Kansas Press Association. Dan Rukes, advertising director of the KPA,
will provide live music. If you have song requests, please e-mail Dan at
drukes@kspress.com.

FEATURED SPONSORS

EKEC

KANSAS ELECTRIC
COOPERATIVES, INC.

A Touchstone Energy’ Cooperative ?@TJ

Saturday, April 30

7am. -3 p.m.

Registration and Contest Display

The registration desk and contest display room will open at 7
a.m.

7 -8 am.

Annual Meeting and Breakfast

8 am.-10:30 a.m.

Newspaper Speed To?ics - Like Speed
Dating... Only Better!

Come and get a short presentation on numerous topics and then
ask the experts! All speed sessions will last 30 minutes. Session
topics are below. Pick your top 3!

- How You Can Improve Your Legislative Coverage

- Online Video Tips

- Selling and Customer Service: Important Allies

- Quick Photography Tips

- Circulation Open Roundtable

- Ask the Media Lawyer

- Coaching Skills for Managers

- How to Use KansasOpenGov.org

- Editorial and Opinion Writing

- Why You Need a Mobile Presence

- Why We Love the new KPA Website

- The KDAN and KCAN Networks: Why Should I Join?

- Important Information to Know When Reporting
on Public Safety Issues

10:30 - 11:30 a.m.

General Session

What Do Print Readers Want?

AMERICAN OPINION RESEARCH

Focusing on printed news content, we look at what readers want,
what most newspapers are providing and how to close the gap
that generally exists between the two.

11:30 am. - I p.m.

Lunch Program

The PEOPLE Model for Today’s Workforce
TIM SMITH

Are you finding it harder and harder to motivate, coach, teach
and train your staff? Are you finding that you are working
harder for the same or even lesser results? This high-energy and
practical approach to a new concept in coaching team will help
the most seasoned manager and organization refocus on their
goals. We will teach the six steps to The PEOPLE Model, define
“what exceptional looks like to you and your organization”, the
resources and skills of successful organizations and what they do
that is different from the average company. We will demonstrate
the communication dynamics and how to communicate more
effectively within your organization. You will walk away from
this session with a new and enthusiastic approach to team

building;

11:30 a.m. - 12:45 p.m.
Past President’s Lunch

1:15 pm. - 2 p.m.

Breakout Sessions

Prospecting that Pays

TIM SMITH

How important is prospecting? Is it a waste of my time? Join Tim
as we explore how to make sure your prospecting PAYS!



Public Affairs: How to Make Meeting Coverage
Relevant and Timely

JIM PUMARLO

Coverage of local governing bodies — school board, city council,
county board — remains a primary responsibility of community
newspapers. But newsrooms must change their approach if they are
to engage readers — put more focus on previewing the meetings and
report on government actions in terms of the practical impact on
readers.

Growing Newspaper Websites

AMERICAN OPINION RESEARCH

While newspaper websites are adding audience reach, most are
not even close to reaching full potential. We provide specific
recommendations almost every newspaper can use to build use,
frequency and revenue from its website, including the latest
information from our new study about user-generated content
and how it affects website use.

2 -2:15 p.m.
Afternoon Break

2:15-3 p.m.

Breakout Sessions

Time and Territory Management

TIM SMITH

If you are like most advertising reps, you have felt at one time or
another that you have a large territory and not enough time. Join
Tim as he gives you tips on how to effectively manage your time and
your territory.

Bad News and Good Judgment:

A Guide to Reporting on Sensitive Issues in

a Small-Town Newspaper

JIM PUMARLO

Identifying suicide victims and reporting names of suspended high
school athletes are among the many challenging news decisions fac-
ing community newspapers. This session will teach participants how
to handle these stories ethically and professionally. It will emphasize
why it’s important to print all the news - the good and bad - and will
help participants understand the three-part process to effectively
handling sensitive stories: Developing the policies, uncovering the
facts and explaining newspaper policies to readers.

Why Journalists Do What They Do

TOM EBLEN

To develop the daily or weekly miracle we call our newspaper, we
follow a proven track of reporting, starting with verification, a chal-
lenge in its own right. We focus briefly on how to handle quotes and
attribution and the art of listening. We consider sources of informa-
tion and how to handle the all-important beats. Our goal, of course,
1s to write accurately and to be fair and to tell each story so well that
readers will understand the issue or issues as well as those who were
there.

3 -4pm.

Daily Roundtable - 2

Nondaily Roundtable - 2

Student &ewspaper Roundtable - 1

4 - 4:30 p.m.
Awards of Excellence Reception

4:30 -6 p.m.
Awards of Excellence Presentation

Tim Smith has worked in the news-
paper and print industry for over nine
years. He started out in Circulation and
was promoted to a supervisory role in
the Production Department due to his
work ethic and his results. He has also
worked on the sales side of the business
again being promoted to Sales Manager
due to his results, especially in revenue,
repeat business and his ability in new
business development.

Tim has delivered tailored training programs on man-
agement skills, customer service and sales training to the
newspaper industry for more than eight years. He has done
keynote speeches, conventions, individual newspapers and
one on one coaching with managers, production, display,
editorial and sales people. He has help several organi-
zations put together their customer service model and
increase sales through more consistent consultative sales
processes with their salespeople.

Jim Pumarlo, spent 27 years work-
ing at small daily newspapers in
Minnesota. Under his leadership,
the Red Wing Republican Eagle
was named best daily newspaper
in the nation in its circulation divi-
sion by the National Newspaper
Association. Pumarlo published
‘ “Bad News, Good Judgment: A

Guide to Reporting on Sensitive
Issues in a Small-Town Newspa-
per.” This year, he’ll share some of the lessons from
that book.

KANSAS
& ACTION For
CHILDREN

KANSAS-POLICY
INSTITUTE




CONTACT INFORMATION

Form

ZIP Code

Newspaper/Company Contact Person
Address City State
Area Code/Phone Fax E-mail

Name of Attendee

S15 if nof registered for
full or Sat. convention

Sat. Breakfast

$20 if not registered for
full or Sat. convention

$12 if not registered for
full or Sat. convention

2 Registration Fees Friday Banquet free wi Saturday Lunch AOE Total
print clearly for name badges please check one $35 per person registration free wiregistratio: free wiregistration| Fees
m) _"_...__ registration - $120 3 Atending 7 Mtending 7 Atending (3 Atending
[ Friday only - $60
(3 Saturday only - $70 [ Not attending (7 Not attending (3 Not attending (7 Not attending
o T_.__ regisiafion - $90 (7 Attending (7 Mtending {1 Attending 07 Attending
[ Friday only - $55
(3 Saturday only - $65 (7 Not attending (7 Not attending (3 Not attending (7 Not attending
o T_.__ regisiafion - $85 (7 Attending (7 Mtending {1 Attending 07 Attending
[ Friday only - $55
(3 Saturday only - $65 [ Not attending (7 Not attending (3 Not attending (7 Not attending
o ?.__ registrafion - S80 (3 Atending 7 Atending {1 Atending O3 Attending
[ Friday only - $55
(3 Saturday only - $65 (7 Not attending [ Not attending (3 Not attending (7 Not attending
{3 Full registration - $80 (7 Atending 3 Atending (7 Attending 1 Attending
[ Friday only - $55
O3 Saturday only - 565 (3 Not attending (7 Not attending (7 Not attending (7 Not attending

PAYMENT METHOD
o Check enclosed (made payable to KPA)

1 Please invoice me at the address above

o Charge to Visa, MasterCard or American Express
Credit Card #
Expiration Date
V-Code (three-digit code on back of card)
Cardholder’s Name

Registrations are requested no later than Friday, April 15.

a Corporate Card (billing address as listed above)

A Personal Card

Please provide billing address below.

Street Address

City, State

Zipcode

Registration

Fees

Convention registration fees include admittance
to all sessions on the day(s) for which you have
paid a registration fee. Additional fees, indicated
on the registration grid above, may apply for some
special activities and meals. Discounts for multiple
registrations from the same newspaper apply, and

are listed on the grid at left.

Late Registrations

Registrations received after April 15 will be
accepted as space permits. On-site registrations are
not encouraged. Late and on-site registrations will

be assessed a $20 late fee.

Nonmembers

Rates listed are for KPA members. For
nonmember rates, please call the KPA office at
(785) 271-5304.

Refunds and Substitutions
Refunds will be issued on changes and cancellations
received by 5 p.m. Friday, April 15. Substitutions
will not be allowed on registrations. If the registered
person is unable to attend, the person will still be
charged even if another person comes in their place.

How to Register

Mail: 5423 SW 7th, Topeka, KS 66606
Fax: (785) 271-7341

E-mail: ebradbury@kspress.com

Overnight Accommodations
Sleeping rooms are being held for KPA convention
attendees at the Courtyard by Marriott until Tuesday,
March 29. For reservations, call 1-785-210-1500. The
room rate is $86 per night.

Questions? Contact the KPA office at 785-271-5304 or ebradbury@kspress.com
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